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Precautions
• For actual system construction, check the specifications for each device and piece of equipment that

makes up the system, use a method with sufficient margin for ratings and performance, and adopt
safety circuits and other safety measures to minimize risks even if a breakdown occurs.

• To safely utilize the system, obtain a manual or user's guide for each device and piece of equipment
that makes up the system, confirm their content, including "Safety Precautions", "Precautions for
Safe Use", and other precautions related to safety, and then proceed with use.

• The customer must check all regulations, laws, and rules that are applicable to the system them-
selves.

The marks used in this document are defined as follows.

Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

Additional Information

Additional information to read as required.
This information is provided to increase understanding and make operation easier.

Precautions
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Related Manuals
Thoroughly read and understand the manuals and user’s guides for all of the devices and equipment
that are used in the system to ensure that the system is used safely. Review the entire contents of
these materials, including all safety precautions, precautions for safe use, and other precautions.
The related manuals of OMRON Corporation (hereafter may be called “OMRON”) and Delta Tau Data
Systems Inc. (hereafter may be called “DT”) are as shown below.

Manufacturer Cat. No. Model Manual name
OMRON W500 NJ501-££££

NJ301-££££
NJ101-££££

NJ-series CPU Unit Hardware User’s Manual

OMRON W593 NX102-££££ NX-series NX102 CPU Unit Hardware User’s Manual
OMRON W578 NX1P2-££££££ NX-series NX1P2 CPU Unit Hardware User’s Manual
OMRON W501 NX701-££££

NX102-££££
NX1P2-££££££
NJ501-££££
NJ301-££££
NJ101-££££

NJ/NX-series CPU Unit Software User’s Manual

OMRON W506 NX701-££££
NX102-££££
NX1P2-££££££
NJ501-££££
NJ301-££££
NJ101-££££

NJ/NX-series CPU Unit Built-in EtherNet/IPTM Port User’s Manual

OMRON W504 SYSMAC-SE2£££ Sysmac Studio Version 1 Operation Manual
OMRON 0969584-7 W4S1-05£

W4S1-03B
Switching Hub W4S1-series Users Manual

OMRON I610 CK3E-1£10 CK3E-series Programmable Multi-Axis Controller Hardware User’s
Manual

OMRON O036 CK5M-CPU1£1
CK3M-CPU1£1

CK3M/CK5M-series Programmable Multi-Axis Controller User's Man-
ual Hardware

DT O014 --- Power PMAC User’s Manual
DT O015 --- Power PMAC Software Reference Manual
DT O016 --- Power PMAC IDE User’s Manual

Related Manuals
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Terms and Definitions
Terms Descriptions and Definitions

Node Controllers and devices are connected to an EtherNet/IP network through EtherNet/IP ports.
EtherNet/IP recognizes each EtherNet/IP port connected to the network as a node.
This means that a connected device that has two EtherNet/IP ports is recognized as two nodes.
EtherNet/IP achieves communications between Controllers, or communications between a Con-
troller and devices, through data exchange between the nodes connected to the network.

Tag The minimum unit of data that can be exchanged over an EtherNet/IP network is called tag. A tag
is defined as a network variable name or physical address and allocated to the memory area of
each device.

Tag set In an EtherNet/IP network, data can be exchanged in a data unit that is composed of two or more
tags. A data unit that is composed of two or more tags for the purpose of data exchange is called
tag set.

Tag data
link

EtherNet/IP supports cyclic exchange of tags and tag sets between nodes without the need for a
user program. This function is called tag data link.

Connec-
tion

The unit of data exchange is called connection. A connection is composed of tags and tag sets.
Opening a synchronous tag data link between specified nodes is called “establishing a connec-
tion.” Once a connection is established, the tags and tag sets that compose the connection are
exchanged synchronously between specified nodes.

Connec-
tion type

There are two connection types for tag data link connections. They are multicast connection and
unicast (point-to-point) connection. Multicast sends a single output tag set in a packet to multiple
nodes. On the other hand, unicast sends a single output tag set to each node individually. This
means that multicast allows a single output tag set to be sent to multiple nodes with less communi-
cations load.

Originator
and target

To perform tag data link communications, one node makes a request to open a communications
line called “connection.”
The node that requests to open a connection is called “originator”, whereas the node that is re-
quested to open a connection is called “target”. The data that is communicated by these nodes is
called “originator variables” and “target variables”, respectively.

Tag data
link pa-
rameters

In tag data link settings, tag data link parameters refer to a set of setting data that consists of “tag
settings”, “tag set settings”, and “connection settings”.

RPI An abbreviation for Requested Packet Interval. Represents a data refresh period set for each con-
nection between originators and targets on an EtherNet/IP network.

EDS file EDS (Electric Data Sheet) is a text-based file that provides device-related information to a pro-
gramming software.
You can use EDS files provided by EtherNet/IP device manufacturers to easily configure connec-
tions.

Power
PMAC IDE

This is computer software that is used to configure the PMAC, create user programs, and perform
monitoring.
PMAC is an abbreviation for Programmable Multi-Axis Controller.

Terms and Definitions
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Revision History
A manual revision code appears as a suffix to the catalog number on the front and back covers of the
manual.

O903-E1-02

Revision code

Revision
code Date Revised content

01 September 2020 Original production

02 January 2023
• Revisions due to the addition of the CK5M-CPU1£1
• Corrected mistakes.

Revision History
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About This Guide

This section describes the overview of this guide.

1-1 Introduction .................................................................................................... 1-2
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1-1 Introduction
This document describes the connecting procedure and confirmation for an OMRON Programmable
Multi-Axis Controller CK3E-££££/CK£M-CPU1£1 (hereinafter sometimes abbreviated as "PMAC")
to an NJ/NX-series CPU Unit via EtherNet/IP.

1 About This Guide
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2
Target Device and System Config-
uration

This section describes the target devices and system configuration to be used for
EtherNet/IP connection in this guide.

2-1 Target Device .................................................................................................. 2-2
2-2 Device Configuration ..................................................................................... 2-3
2-3 Connection Configuration............................................................................. 2-4
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2-1 Target Device
The devices to be used in this guide are as follows.

Manufacturer Name Model
OMRON CK3E-series Programmable Multi-Axis Controller CK3E-££££
OMRON CK3M/CK5M-series Programmable Multi-Axis Controller CK5M-CPU1£1

CK3M-CPU1£1
OMRON NJ/NX-series CPU Unit NX701-££££

NX102-££££
NX1P2-££££££
NJ501-££££
NJ301-££££
NJ101-££££

OMRON Industrial Switching Hub W4S1-0££

Precautions for Correct Use

The connection procedures and confirmation methods in this document use the models and
versions of devices described in 2-2 Device Configuration on page 2-3 among the above tar-
get devices.
You cannot use devices whose versions are older than those listed in 2-2 Device Configuration
on page 2-3.
To use models that are not listed in 2-2 Device Configuration on page 2-3 among the above
target devices, or devices whose versions are newer than those listed in 2-2 Device Configura-
tion on page 2-3, check their manuals or user’s guides to confirm differences in the specifica-
tions before use.

Additional Information

This document provides the connection procedures to establish communications. It does not
provide information other than the connection procedures, such as the operation, installation,
wiring, and functions and motions of the devices. Refer to the relevant manuals or user’s
guides, or contact your OMRON representative.

2 Target Device and System Configuration
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2-2 Device Configuration
The configuration devices for reproducing the connection procedures in this document are shown be-
low.

CK3M-CPU1£1

Power PMAC IDE

Sysmac Studio

Ethernet

NJ501-1500

EtherNet/IP

W4S1-05B

EtherNet/IP

Manufacturer Name Model Version
OMRON NJ/NX-series CPU Unit (With built-in EtherNet/IP

port)
NJ501-1500 Ver. 1.21 or later

OMRON Power Supply Unit NJ-PA3001 ---
OMRON Industrial Switching Hub W4S1-05B ---
OMRON Sysmac Studio SYSMAC-SE2£££ ---
OMRON Programmable Multi-Axis Controller CK3M-CPU1£1 Ver. 2.5.4 or later
OMRON Industrial Switching Hub W4S1-05B ---
OMRON Ethernet Cable (Industrial Ethernet connector cable) XS5W-T421-£M£-K ---
DT Power PMAC IDE --- Ver. 4.4 or higher

Precautions for Correct Use

Auto-update the Sysmac Studio to the version specified in this section or later. Using a version
that is not specified in this section may cause differences in the procedures in Section 3 and
later. In that case, refer to the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) to
perform equivalent procedures.

Additional Information

This manual describes the connection example of the NJ501-1500 and CK3M-CPU1£1. The
same procedure can be used to connect a CK3E-££££ or a CK5M-CPU1£1 and other
NJ/NX-series CPU Unit.

2 Target Device and System Configuration
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2-3 Connection Configuration
This section describes the connection configuration of the PMAC and NJ/NX-series CPU Unit that you
will set in this guide.

Originator Target Connection I/O Type Size RPI Number of con-
nections

NJ/NX-series CPU
Unit

PMAC Exclusive Owner 504 bytes each for input
and output

50 ms 16

The correspondence of variables between each node is listed below.

Variable name on the NJ/NX-series CPU Unit side Variable name on the NJ/NX side
eip_from_ppmac_XX
(XX: Connection number)

Eip[XX].Output.Udata[YY]
(XX: Connection number, YY: Number of array elements)

eip_to_ppmac_XX Eip[XX].Input.Udata[YY]

2 Target Device and System Configuration
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3
EtherNet/IP Connection Proce-
dures

This section describes the procedures for connecting the NJ/NX-series CPU Unit and
PMAC via EtherNet/IP to enable communications between them. The description as-
sumes that the NJ/NX-series CPU Unit and PMAC are set to factory default.

3-1 Work Flow ....................................................................................................... 3-2
3-2 NJ/NX-series CPU Unit Settings ................................................................... 3-3

3-2-1 Creating a New Project ................................................................................... 3-3
3-2-2 Setting the Network ......................................................................................... 3-3
3-2-3 Setting Variables ............................................................................................. 3-4
3-2-4 Creating and Checking the User Program ...................................................... 3-5
3-2-5 Setting EtherNet/IP (Tag Sets) ........................................................................ 3-9
3-2-6 Installing the EDS File ................................................................................... 3-10
3-2-7 Setting EtherNet/IP (Connections) .................................................................3-11

3-3 Preparations for Setting the PMAC ............................................................ 3-13
3-3-1 Creating a New Project ................................................................................. 3-13
3-3-2 Performing the Initial Settings for the PMAC................................................. 3-14

3-4 PMAC EtherNet/IP Settings ......................................................................... 3-16
3-4-1 Setting Connection 1 ..................................................................................... 3-16
3-4-2 Setting Connections 2 to 16 .......................................................................... 3-18

3-5 PMAC Settings.............................................................................................. 3-19
3-5-1 Creating a User Program .............................................................................. 3-19
3-5-2 Transferring Project Data and Checking the Operation................................. 3-19
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3-1 Work Flow
The procedures for connecting the NJ/NX-series CPU Unit and PMAC via EtherNet/IP to enable com-
munications between them are shown below.

3-2 NJ/NX-series CPU Unit Settings on page
3-3

Perform the preparation for connecting the
NJ/NX-series CPU Unit.

q

3-2-1 Creating a New Project on page 3-3
q

3-2-2 Setting the Network on page 3-3
q

3-2-3 Setting Variables on page 3-4
q

3-2-4 Creating and Checking the User Program on page 3-5
q

3-2-5 Setting EtherNet/IP (Tag Sets) on page 3-9
q

3-2-6 Installing the EDS File on page 3-10
q

3-2-7 Setting EtherNet/IP (Connections) on page 3-11
s

3-3 Preparations for Setting the PMAC on
page 3-13

Perform the preparations for setting the
PMAC.

q

3-3-1 Creating a New Project on page 3-13
q

3-3-2 Performing the Initial Settings for the PMAC on page 3-14
s

3-4 PMAC EtherNet/IP Settings on page 3-16 Perform the EtherNet/IP settings.
q

3-4-1 Setting Connection 1 on page 3-16
q

3-4-2 Setting Connections 2 to 16 on page 3-18
s

3-5 PMAC Settings on page 3-19 Perform the PMAC settings.
q

3-5-1 Creating a User Program on page 3-19
q

3-5-2 Transferring Project Data and Checking the Operation on
page 3-19

3 EtherNet/IP Connection Procedures
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3-2 NJ/NX-series CPU Unit Settings
Configure the devices for connection to the network.

3-2-1 Creating a New Project

1 Connect the CPU Unit and a computer
with a USB cable.

2 Turn ON the power supply to the CPU
Unit.

3 Start up the Sysmac Studio.

• If a dialog box for checking access
rights is displayed at the time of start-
up, select the option for starting up.

4 In the Sysmac Studio, create a new
project.

• Project Properties
Enter the Project name and other in-
formation.

• Select Device
Select Controller as the Category.
Set the Device and Version accord-
ing to the device to connect. Here,
select NJ501-1500 and 1.21.

Click the Create button.

3-2-2 Setting the Network
Change the IP address of the NJ/NX-series CPU Unit to one that enables connection to the PMAC.

1 In the Multiview Explorer, double-click
Built-in EtherNet/IP Port Settings un-
der Configurations and Setup –
Controller Setup.

3 EtherNet/IP Connection Procedures
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2 In the TCP/IP Settings view of the
Built-in EtherNet/IP Port Settings tab
page, set the IP Address*1 to enable
connection to the PMAC.

*1. Set this to the same network address as that of the PMAC.

3-2-3 Setting Variables
Add variables to use in the user program and for EtherNet/IP communications.

1 Define date types to use for the varia-
bles to add.

In the Multiview Explorer, double-click
Data Types under Programming –
Data.

2 As shown on the right, add the name of
the data type as eip_Connection.
Next, add a member with the name i_1
and the data type UDINT.
Similarly, add the subsequent members
up to i_126.

Data types are added in this way be-
cause the test program uses 126 varia-
bles of the UDINT data type, which add
up to 504 bytes.

3 Add variables to use.

In the Multiview Explorer, double-click
Global Variables under Programming
– Data.

3 EtherNet/IP Connection Procedures
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4 As shown on the right, add a variable
with the name eip_from_ppmac_01, the
data type eip_Connection, and the net-
work publish setting of Input.
Similarly, add the subsequent variables
up to eip_from_ppmac_16.

Variables are added in this way be-
cause the test program and EtherNet/IP
use 16 connections for input.

5 As shown on the right, add a variable
with the name eip_to_ppmac_01. the
data type eip_Connection, and the net-
work publishs setting of Output.
Similarly, add the subsequent variables
up to eip_to_ppmac_16.

Variables are added in this way be-
cause the test program and EtherNet/IP
use 16 connections for output.

3-2-4 Creating and Checking the User Program
Create a program for the operations check.
The operations check program uses the ST language. Refer to the NJ/NX-series CPU Unit Software
User’s Manual (Cat. No. W501) for details.

1 Adding a user program (ST)

In the Multiview Explorer, right-click
Programs under Programming and select
Add – ST from the menu.

2 Selecting the user program (Program1)

In the Multiview Explorer, double-click
Program1 under Programming –
Programs.

3 EtherNet/IP Connection Procedures
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3 Adding variable definitions to use in the
user program

Click Variables and, in the Externals tab
page, add a variable with the name
eip_from_ppmac_01 and the data type
eip_Connection.

Similarly, add the subsequent variables up
to eip_from_ppmac_16.

Similarly, add variables from
eip_to_ppmac_01 up to eip_to_ppmac_16.

3 EtherNet/IP Connection Procedures
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4 In the programming area, write the program
listed on the right.

This program example outputs the values of
the first, middle, and last variables for Input
Connections 1 to 16 to the first, middle, and
last variables for Output Connections 1 to
16.

It sends back the transmission data from
the PMAC.

eip_to_ppmac_01.i_1   := eip_from_ppmac_01.i_1;
eip_to_ppmac_01.i_63  := eip_from_ppmac_01.i_63;
eip_to_ppmac_01.i_126 := eip_from_ppmac_01.i_126;
eip_to_ppmac_02.i_1   := eip_from_ppmac_02.i_1;
eip_to_ppmac_02.i_63  := eip_from_ppmac_02.i_63;
eip_to_ppmac_02.i_126 := eip_from_ppmac_02.i_126;
eip_to_ppmac_03.i_1   := eip_from_ppmac_03.i_1;
eip_to_ppmac_03.i_63  := eip_from_ppmac_03.i_63;
eip_to_ppmac_03.i_126 := eip_from_ppmac_03.i_126;
eip_to_ppmac_04.i_1   := eip_from_ppmac_04.i_1;
eip_to_ppmac_04.i_63  := eip_from_ppmac_04.i_63;
eip_to_ppmac_04.i_126 := eip_from_ppmac_04.i_126;
eip_to_ppmac_05.i_1   := eip_from_ppmac_05.i_1;
eip_to_ppmac_05.i_63  := eip_from_ppmac_05.i_63;
eip_to_ppmac_05.i_126 := eip_from_ppmac_05.i_126;
eip_to_ppmac_06.i_1   := eip_from_ppmac_06.i_1;
eip_to_ppmac_06.i_63  := eip_from_ppmac_06.i_63;
eip_to_ppmac_06.i_126 := eip_from_ppmac_06.i_126;
eip_to_ppmac_07.i_1   := eip_from_ppmac_07.i_1;
eip_to_ppmac_07.i_63  := eip_from_ppmac_07.i_63;
eip_to_ppmac_07.i_126 := eip_from_ppmac_07.i_126;
eip_to_ppmac_08.i_1   := eip_from_ppmac_08.i_1;
eip_to_ppmac_08.i_63  := eip_from_ppmac_08.i_63;
eip_to_ppmac_08.i_126 := eip_from_ppmac_08.i_126;
eip_to_ppmac_09.i_1   := eip_from_ppmac_09.i_1;
eip_to_ppmac_09.i_63  := eip_from_ppmac_09.i_63;
eip_to_ppmac_09.i_126 := eip_from_ppmac_09.i_126;
eip_to_ppmac_10.i_1   := eip_from_ppmac_10.i_1;
eip_to_ppmac_10.i_63  := eip_from_ppmac_10.i_63;
eip_to_ppmac_10.i_126 := eip_from_ppmac_10.i_126;
eip_to_ppmac_11.i_1   := eip_from_ppmac_11.i_1;
eip_to_ppmac_11.i_63  := eip_from_ppmac_11.i_63;
eip_to_ppmac_11.i_126 := eip_from_ppmac_11.i_126;
eip_to_ppmac_12.i_1   := eip_from_ppmac_12.i_1;
eip_to_ppmac_12.i_63  := eip_from_ppmac_12.i_63;
eip_to_ppmac_12.i_126 := eip_from_ppmac_12.i_126;
eip_to_ppmac_13.i_1   := eip_from_ppmac_13.i_1;
eip_to_ppmac_13.i_63  := eip_from_ppmac_13.i_63;
eip_to_ppmac_13.i_126 := eip_from_ppmac_13.i_126;
eip_to_ppmac_14.i_1   := eip_from_ppmac_14.i_1;
eip_to_ppmac_14.i_63  := eip_from_ppmac_14.i_63;
eip_to_ppmac_14.i_126 := eip_from_ppmac_14.i_126;
eip_to_ppmac_15.i_1   := eip_from_ppmac_15.i_1;
eip_to_ppmac_15.i_63  := eip_from_ppmac_15.i_63;
eip_to_ppmac_15.i_126 := eip_from_ppmac_15.i_126;
eip_to_ppmac_16.i_1   := eip_from_ppmac_16.i_1;
eip_to_ppmac_16.i_63  := eip_from_ppmac_16.i_63;
eip_to_ppmac_16.i_126 := eip_from_ppmac_16.i_126;

3 EtherNet/IP Connection Procedures
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5 Adding the user program execution settings

In the Multiview Explorer, double-click Task
Settings under Configurations and
Setup.

Click the Program Assignment Settings
button and set Program1 to Run.

6 Transferring the non-EtherNet/IP settings
and user program

Click the Online icon in the toolbar.

Then, click the Synchronization icon on
the right side.

Click the Transfer to Controller button.

• If the message shown on the right ap-
pears, click the Yes button.

• If the message shown on the right ap-
pears, click the Yes button.

3 EtherNet/IP Connection Procedures
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• The transfer is successful if the The
Synchronization process successfully
finished. message is displayed. Click the
Close button.

3-2-5 Setting EtherNet/IP (Tag Sets)

1 Select EtherNet/IP Connection
Settings from the Tools menu.

2 Double-click the row that contains
192.168.0.1.

3 Setting the input tag sets

Right-click on the Input tab page and
select Create New Tag Set from the
menu.

Enter eip_from_ppmac_01 as the tag
set name.

4 Setting the input tags

Right-click on the Input tab page and
select Create New Tag from the menu.

Enter eip_from_ppmac_01 as the tag
name.

Similarly, create the subsequent tag
sets and tags up to
eip_from_ppmac_16.

3 EtherNet/IP Connection Procedures
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5 Setting the output tag sets

Click the Output tab to switch to the
Output tab page.

Right-click on the Output tab page and
select Create New Tag Set from the
menu.

Enter eip_to_ppmac_01 as the tag set
name.

6 Setting the output tags

Right-click on the Output tab page and
select Create New Tag from the menu.

Enter eip_to_ppmac_01 as the tag
name.

Similarly, create the subsequent tag
sets and tags up to eip_to_ppmac_16.

3-2-6 Installing the EDS File
You need to install the EDS file only at the initial use of the device.

1 Right-click the Toolbox and select
Display EDS Library from the menu.

2 Click the Install button.

3 Select the check box for the EDS file to
install and click the Open button.

4 Click the + icon in the Toolbox pane.

3 EtherNet/IP Connection Procedures
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5 Select the IP address and model name
of the PMAC to use.
For the revision, select 1.
When you finished entering the data,
click the Add button.

• In this document, the default PMAC
address (192.168.0.200) is used.

3-2-7 Setting EtherNet/IP (Connections)

1 Click the Connection icon.

2 Setting Connection 1

Next, click the + icon.

For the added row, set the items as fol-
lows.
Target Device: PMAC to use
Connection I/O Type: Exclusive Owner
1
RPI: 50.0 ms
Target Variable: 768 for inputs and 769
for outputs*1

Size: 504
Originator Variable:
eip_from_ppmac_01, eip_to_ppmac_01
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3 Setting Connections 2 to 16

Set connections 2 to 16 in the same
way as described above.
For each connection, change the
Exclusive Owner number and other
data from 1 to up to 16.
For the Target Variable, set the value
in increments of +4, i.e., 768 is followed
by 772 for inputs and 769 is followed by
773 for outputs.

4 Select Device Bandwidth and make
sure that the bandwidth used by the de-
vice is within the specification range of
the PMAC.

5 Click the Transfer to Controller button.

• If the message shown on the right
appears, click the Yes button.

• If the message shown on the right
appears, select Change to
PROGRAM mode and execute the
transfer.

6 If the message shown on the right ap-
pears after completion of transfer, click
the Yes button.

*1. These numbers specify the instance IDs of the Assembly objects. For more information, refer to CK3M/
CK5M-series Programmable Multi-Axis Controller User's Manual Hardware (Cat. No. O036), A-7-2
Assembly Object (Class ID: 04 Hex) or CK3E-series Programmable Multi-Axis Controller Hardware User’s
Manual (Cat. No. I610), A-3-2 Assembly Object (Class ID: 04 Hex).
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3-3 Preparations for Setting the PMAC
Perform the preparations for setting the PMAC.

3-3-1 Creating a New Project

1 Turn ON the power supply to the
PMAC.

2 Start up Power PMAC IDE.

• If a dialog box for checking access
rights is displayed at the time of start-
up, select the option for starting up.

3 The Communication Setup dialog box is
displayed, so specify the IP address of
the PMAC to connect to, and click the
Connect button.
• The default IP address for the PMAC

is "192.168.0.200".
• If necessary, change the Windows IP

address to "192.168.0.X".

4 Power PMAC IDE starts up, and the
PMAC goes online.

5 From the File menu, select New –
Project.
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6 Enter the type of project for which
EtherNet/IP can be set, desired project
name, and the save destination, and
click the OK button.

3-3-2 Performing the Initial Settings for the PMAC
Perform the initial settings for the PMAC.

Precautions for Correct Use

Since all memory is cleared by the initial settings, be sure to save any data remaining in the
PMAC that you may need.

1 Execute the $$$*** command from the
Terminal to set the PMAC to the factory
default state.

2 In the Solution Explorer, select System
– CPU – System.

3 Select Clock Settings.
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4 Set the servo frequency.

In Servo Frequency, select 4 kHz, 2
kHz, or 1 kHz.

• This document gives an example of
setting this to 1 kHz.

5 Click the Accept button.

6 If you change the servo frequency set-
ting, execute the save command from
the Power PMAC IDE Terminal.
When the save command is completed,
"Save Completed" is displayed in the
Terminal.

7 Click the Communication Setup icon
in the toolbar to display the Communi-
cation Setup dialog box.

8 In the Communication Setup dialog
box, click the No Device button.

The Terminal goes offline.

9 Start up the PMAC.

The set servo frequency is reflected.

10 Wait until the PMAC starts up, and click
the Communication Setup icon in the
toolbar to display the Communication
Setup dialog box.
In the Communication Setup dialog
box, click the Connect button.

The Terminal goes online.
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3-4 PMAC EtherNet/IP Settings
Perform the EtherNet/IP settings.

Precautions for Correct Use

Check that devices are connected with Ethernet cables before you perform the following proce-
dures. If devices are not connected, turn OFF the power supply to them, and then connect
Ethernet cables.

3-4-1 Setting Connection 1

1 Connect the PMAC and devices with
Ethernet cables.

• For the settings of connected devi-
ces, refer to the manuals for the con-
nected devices.

2 Setting Connection 1

In the Solution Explorer, select System
– EtherNet/IP(Deactivated) –
Connection1.

3 Selecting the type of variables to add to
Connection 1 (Input)

Select the data type of variables to add
to Connection1.
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4 Add variables as many as the specified
number to Connection 1 (Input).

Select the Inputs tab page for
Connection1. Click the Add Variables
button, specify the number of variables
to add, and click the OK button.

5 Checking and completing Connection 1
(Input)

Check the size of the Connection1 in-
put settings and click the Accept but-
ton.

6 Selecting Connection 1 (Output)

Select the Outputs tab page for
Connection1.

7 Add variables as many as the specified
number to Connection 1 (Output).

Select the Add Variables button for
Connection1, specify the number of
variables to add, and click the OK but-
ton.
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8 Checking and completing Connection 1
(Output)

Check the size of the Connection1 out-
put settings and click the Accept but-
ton.

3-4-2 Setting Connections 2 to 16

1 Copy the settings of Connection 1 to
other connections.

In the Solution Explorer, right-click
Connection1 under System –
EtherNet/IP(Deactivated) and select
Copy from the menu.

2 In the Solution Explorer, right-click
EtherNet/IP(Deactivated) under
System and select Paste from the
menu.

To add the settings to Connections 2 to
16, enter as shown on the right and
click the OK button.
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3-5 PMAC Settings

3-5-1 Creating a User Program
Create a program for the operations check.
The operations check program uses the special language. For details, refer to the Power PMAC
User’s Manual (Cat. No. O014) and Power PMAC Software Reference Manual (Cat. No. O015).

1 In the Solution Explorer, select PMAC
Script Language – PLC Programs –
plc1.plc.

2 In the programming area of the
plc1.plc tab page, write the program as
shown on the right.

This program example adds 1 to the
first, middle, and last input variables for
Connections 1 to 16 and outputs the
values to the first, middle, and last out-
put variables for Connections 1 to 16.
The values are counted up because the
program is set to turn back the values
at each connected device.

open plc Myplc1

L0 = P0

Eip[L0].Output.Udata[0] = Eip[L0].Input.Udat
a[0] + 1
Eip[L0].Output.Udata[62] = Eip[L0].Input.Udat
a[62] + 1
Eip[L0].Output.Udata[125] = Eip[L0].Input.Uda
ta[125] + 1

P0 = P0 + 1
if ( P0 >= 16 ) P0 = 0 

close
3 Configuring the startup settings of the

user program

In the Solution Explorer, select
Configuration – pp_startup.txt.

4 In the programming area of the
pp_startup.txt tab page, add the pro-
gram given on the right to the last line.

The pp_startup.txt is automatically
executed when the PMAC starts up.
In this example, the PLC1 script is exe-
cuted.

enable plc 1;

3-5-2 Transferring Project Data and Checking the Operation
Transfer the created project data to the PMAC.
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1 Downloading the project

In the Solution Explorer at the upper
right of the Power PMAC IDE window,
right-click the project name and select
Build and Download All Programs to
build and download all programs.
• Transfer alone will not save the

project to the PMAC.
If the power to the PMAC is switched
OFF, the transferred project is dis-
carded.

2 Make sure that there are no errors in
the Output tab page.

• If the transfer failed, check the error
information in the Output tab page.
If there is a program error, review the
program.
If the error is caused by the Ether-
Net/IP settings, return to 3-4 PMAC
EtherNet/IP Settings on page 3-16
and check the settings to see if they
are correct.

3 Confirm that there are no errors, and
then save the project to the PMAC.

Execute the save command from the
Terminal.

• By executing the save command, the
downloaded project is stored in the
PMAC. Use this operation to save
the settings that are executed auto-
matically when the power supply to
the PMAC is turned ON.

4 Enabling EtherNet/IP (Restart)

Execute the $$$ command from the
Terminal. The EtherNet/IP settings are
enabled when the PMAC restarts using
the downloaded project.
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5 Checking that EtherNet/IP is enabled

In the Solution Explorer, check that
there is EtherNet/IP (Activated) folder
under System. This indicates that the
EtherNet/IP settings are enabled.

6 Checking that EtherNet/IP is operating

Check that the variables shown on the
right are added and counted up in the
Watch window. This indicates that
EtherNet/IP is operating normally.
If EtherNet/IP is not operating, you can
use the Network Configurator’s Device
Monitor function to perform trouble-
shooting. Refer to 16-2 Checking
Status with the Network Configurator in
the NJ/NX-series CPU Unit Built-in

EtherNet/IPTM Port User’s Manual (Cat.
No. W506) for details.
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A-1 Saving and Reading the Project
This appendix describes the procedure to save the Power PMAC IDE project to the computer for the
purpose of reuse.

A-1-1 Saving the Project

1 Saving the Project

Select Save All from the File menu to
save the project to the computer.

A-1-2 Reading and Downloading the Project

1 Start up and connect Power PMAC IDE
to the Controller.

2 Execute the $$$*** command from the
Terminal to revert the PMAC to the fac-
tory default settings.

3 From the File menu, select Open –
Project/Solution to read the saved
project.
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4 In the Solution Explore, right-click the
project name and select Build and
Download All Programs to build and
download all programs.

After the download is completed, make
sure that there are no errors in the Out-
put tab page.

5 Saving the downloaded settings and
programs

After the download is completed and
you make sure that there are no errors
in the Output tab page, execute the
save command from the Terminal.

• By executing the save command, the
downloaded project is stored in the
PMAC. Use this operation to save
the settings that are executed auto-
matically when the power supply to
the PMAC is turned ON.

6 Restarting the PMAC after download

Execute the $$$ command from the
Terminal and use the downloaded
project to restart the PMAC.
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